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2 INFINITY Test and Homework Generator

Welcome to the INFINITY Test and Homework Generator documentation. This 

manual explains how to get the most out of the software.    

Getting Started (page 4) shows you how to quickly create your first test, from 

installation of the program to printing out.

Constructing Tests (page 18) goes into more detail about each aspect of test 

generation.

Customising Questions (page 28) describes how to make each question use 

values that you select, as well as how you can create your own questions.

1. Introduction

INFINITY Test and Homework Generator has been designed to allow teachers of 

mathematics to quickly and easily construct test papers with an accompanying 

solution page. Available test questions can be easily browsed by book or 

chapter and inserted into tests. 

Tests can be customised in many ways including: 

• Question parameters 

• Question order 

• Margins 

• Headers 

• Allocated marks. 

The final form of test and solution sheets can be previewed on screen and then 

printed. 

Other features of INFINITY Test and Homework Generator include:

• Hundreds of customisable maths questions with worked solutions 

• An interactive Test Wizard to help you quickly and easily create tests 

• The ability to customise the look of test and solution pages with headings 

and space between questions 

• A solution sheet that is automatically produced along with selected test 

questions 

• High quality printed results

• An intuitive and easy to use interface

• The ability to expand with more question databases. 

INFINITY Test and Homework Generator Features
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3. Getting Started

Installation

When you enter the CD, the installation should start automatically.

If it does not, follow the instructions in Step 1 of the Installation section on Page 11.

Step 1

Click on Install.

Follow the instructions given in the 

installer. On the End User License 

Agreement  page,  read the 

agreement and tick the checkbox to 

accept the terms.

Step 2

At the Customer Information Screen, 

enter the School name used when 

ordering your copy of INFINITY Test 

and Homework Generator, and the 

CD Key that came with the software.
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Step 3

Click on Next to install to the default 

directory.

At the next screen click on Install. 

The installation will now start.

When the installation process is 

complete, click on Finish to return 

to the Database Setup Wizard.

Follow the prompts to install the 

database(s). Once this is completed 

click Finish to exit the Setup Wizard.

Step 1

Navigate to where INFINITY 

Te s t  a n d  H o m e w o r k  

Generator was installed, and 

double-click on the icon 

Infinity.exe.

The main w indow of  

INFINITY should now be 

open. This is shown on the 

right.

Starting the Software

Step 2

You will see the following dialog 

asking you to update your database 

licences. 

Click Yes to continue. 

(This requires an internet connection).  
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Step 3

Click where it says <Click to 

select> to open up the Select 

Database dialog. 

Step 1

The next dialog you see will be the 

Test creation Wizard, which is shown 

on the right.

Click Next to continue.

The Test Creation Wizard

Step 2

Select the Blank Test Style, as shown 

in the diagram. Click Next. 
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Finished

Click Finish to open the database, 

and begin selecting questions. 

Step 4

Select a database and click OK.

Step 5

You should now be back at the 

previous page of the wizard. In the 

School Name box, type in the name 

of your school.

In the Subject box, type in the 

subject 

(such as ‘Year 6 Mathematics’).

In the Test Title box type the name 

of your test (such as 'Test Title').

The picture on the right shows you 

what the dialog box should now look 

like. Once it does, click Next to 

continue. 
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Selecting Questions

Step 1

You will now be at the main 

window: 

Use the navigation buttons 

 and  at the bottom of the 

screen to navigate to 

Question 3 (shown in the 

text box between the  and 

. buttons).

Click on the Include In Test check box to add this question to the test. The check box 

should now be ticked, like this: 

Step 2

In the same way, navigate to questions 6, 12, 16 and 18, and include each of them in the 

test.

When you are done, select Print Preview... from the File menu. 

Previewing and Printing

Step 1

When the Print Preview 

window is opened, the 

whole page is shown. Click 

once on the page to zoom 

in. It should look something 

like the picture alongside:
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Step 2

Click on the Show drop-down menu, and 

select Answer Sheet. The view will change to 

show you the answer sheet for the questions you 

selected.

Step 3

Step 4

Click on the  button (in the top left  
hand corner to bring up the Print 

dialog box.

Select your printer as you normally 

would, then click OK to print. This 

will print both the test paper and the 

solution sheet. 

Congratulations!

Congratulations on making your first test. Following the same process you can 

make tests for each topic in the database, and also combine questions from 

different topics. Play around with the Generate button to generate variations 

on the questions.

Happy test writing!
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4. Installing the Software

System Requirements

Minimum requirements

Recommended

Required resources

INFINITY Test and Homework Generator runs successfully on Windows XP, Windows Vista 

and Windows 7. Currently it does not include a version that runs on Mac OS X or Linux.

• Windows XP, Windows Vista or Windows 7.

• At least 32MB of free memory

• 12MB of disk space + about 30MB per database

•  Monitor capable of resolution 800×600 or larger

•  Windows XP (service pack 3) or later

• 256MB memory

• 200MB free disk space

• Resolution of 1024×768 or larger

• The INFINITY Test and Homework Generator installation CD

• The serial key that came with the installation CD (Note: this is case-sensitive)

• The school name used when purchasing the software (Note: this is case-sensitive)
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Installation (Local)

Step 1

When you enter the CD, the 

i n s t a l l a t i o n  s h o u l d  s t a r t  

automatically. If it does not, open 

the CD. Double click on the 

'snowflake' icon.

Click on Install for normal 

installation.

Step 2

Clicking Next on the following 

dialog will check your computer for 

older installations of INFINITY.

Step 3

You will then be notified if there are 

any other installations of INFINITY 

on your system.

If no other installations are found 

you will see the dialog on the right.

Click Next to begin the software 

installation.

This section describes the process 

for a first-time installation of 

INFINITY Test and Homework 

Generator. If INFINITY has already 

been installed the process may 

differ.
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Step 6

At the Customer Information 

screen, enter the School name 

used when ordering your copy of 

INFINITY Test and Homework 

Generator, and the CD Key  that 

came with the software.

Once you have entered the 

information, click Next to 

continue.

Step 4

Click Next to continue.

Step 5

On the End User Licence Agreement 

(EULA) page, read the licence and 

tick the checkbox to accept the 

terms.

If you wish to print the EULA for your 

records, click Print.

Click Next to continue.
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Step 9

If INFINITY Test and Homework 

Generator has installed correctly, 

you will see the screen on the right.

Click on Finish to exit the software 

setup wizard.

This will return you to the database 

setup wizard.

Step 8

At the next screen click on Install to 

start the installation.

You may review and/or change any 

of your installation settings by using 

the Back button to get to the desired 

screen.

Step 7

If you want INFINITY Test and 

Homework Generator to be 

installed in the default directory, 

click Next.

If a different directory is desired, 

click on the Browse... button, and 

navigate to a different directory. 

Alternatively, type in the path to the 

folder where you want Test 

Generator installed. Click Next 

when you are done.
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Step 11

If the database installation was 

successful you will see the dialog on 

the right.

Click Finish to close the database 

setup wizard.

The software and the question 

database will now be installed and 

ready to run.

Step 10

You will now be prompted to install 

the question database(s) which were 

ordered with the software. 

Click Next to begin the database 

installation.

Network Installation and Administration

This section is intended for network administrators at schools. 

INFINITY Test and Homework Generator can be installed on a network drive by selecting 

the network option during installation. Installing INFINITY to a network location will allow 

multiple users to easily access the software from a single location.

Starting a Network Installation

To begin a network installation, run the executable file from the CD. From the first dialog 

that appears click the Network button. You will then be prompted to enter an installation 

location. The installation will now procced in a similar fashion to a local installation. If an 

installation location is chosen which does not have the required available space, 

INFINITY will instead be installed to the network drive with the most available space.
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Running a Network Installation

A network installation offers the same functionality as a local installation of INFINITY. It 

can be run by double-clicking the Infinity.exe icon in the chosen installation location. It is 

advised that users are provided with a shortcut to this file.

Updating a Network Installation

When checking for updates from a network installation a warning prompt will be 

displayed. This prompt explains that updating whilst multiple 'instances' of INFINITY are 

running may have undesirable effects. To ensure updates are successful updating must 

be performed when only one instance of the software is being run over the network.

Network Uninstallation

No mechanism has been provided for automated removal of a network installation. To 

remove a network installation simply remove all of the associated files.

Converting Databases (from .mdb) 

Administrators may convert old databases using the supplied tool ConvertTestDB.exe, 

which is located in the same directory as INFINITY Test and Homework Generator. The 

tool may be run in quiet mode (/q) which hides the progress bar.

User Files

Individual users will have their own copy of preference information. This includes 

information about default directories, zoom levels and test defaults. These files are saved 

in each user’s Application Data / Infinity directory. In addition to preference 

information, custom question databases are also stored in this directory. 

Usage:  ConvertTestDB [/q] path-to-old-database.mdb path-to-new-database.tdb
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5. Managing the Software

INFINITY Test and Homework Generator comes with a Database Manager feature, that 

tells you:

• The databases you currently have installed

• How many days are left on your current licence(s).

Select Licence Manager... from 

the Tools menu to open the Licence 

Manager.

This will present you with a dialog 

showing you which databases are 

currently installed and their licence 

information. 

Updating licences

You can obtain the latest licences 

that your school has purchased by 

clicking on Update licences.

INFINITY Test and Homework 

Generator will then display how 

many days are left on the current 

licence(s).

(Note: You must be connected to the internet )

Licence Manager

Upgrading from Test Generator

If you have upgraded from Test Generator, it may be necessary to relocate your old       

databases. By default, databases in Test Generator are locally installed to:

C:\Program Files\Haese & Harris\Test Generator\db

However, by default, databases for INFINITY are locally installed to:

C:\Program Files\Haese & Harris\Infinity\db

In order to use Test Generator databases in INFINITY, you will need to copy the files in  

Test Generator\db  to  Infinity\db .
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Checking for updates

Clicking on Check For Updates... from the tools menu will search for all updates 

applicable to your current installation.

(Note: You must be connected to the internet.)

Make sure the updates you want to 

apply are ticked (as shown) and click 

Download and install updates.

Should you encounter difficulties 

during the update process, clicking 

on Website will open the contact 

details page on the Haese 

Mathematics website. Our contact 

details may also be found on page 

32.

Database Registration

When opening a database you may 

encounter the following message:

If this happens, click Yes to open the 

Licence Manager.

Step 1

Obtain the latest licences that your 

school has purchased by clicking on 

Update Licences.

(Note: You must be connected to the internet.)

Step 2

Once the licence information has been updated, close the Licence Manager.

You will now be able to open the relevant database.

Updating a database will require that database to be closed.

Updating the software will require INFINITY to be closed.
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6. Constructing a Test

To learn about the different aspects of creating a maths test using INFINITY Test and 

Homework Generator, follow the steps below.

1. Using the Test Wizard explains how to create test outlines quickly and easily with 

the Test Wizard interface.

2. Selecting a Question Database explains how to choose a database of 

questions to work with.

   3. Browsing and Selecting Questions explains how questions can be viewed and 

inserted into a test.

   4. Creating Test and Solution Headers explains how to customise the look of tests 

with headers.

   5. Previewing and Printing a Test explains how to preview a test and make 

changes to the layout before printing.

Using the Test Wizard

The Test Wizard creates a simple test outline ready for question insertion. The test 

created by the wizard can be further modified to create tests with more complex layouts. 

Step 1

The Test Wizard can be shown 

when INFINITY Test and Homework 

Generator is started. The check box 

at the bottom of the window lets you 

change this preference. It is also 

possible to start the wizard from the 

File menu. 
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Step 2

The Test Wizard gives a choice of 

two styles for the tests it creates:

The Test Style places a short 

header at the top of the first page 

followed by the questions directly 

underneath.

The Exam Style places titles and 

instructions to students on a 

separate cover page. The 

questions then begin on the 

second page.

You may also select a previously created template from a list shown. INFINITY Test and 

Homework Generator searches for these templates in the same directory as it is installed, 

but this may be changed through the Preferences dialog. For more information, see 

Using Test Templates (page 25). 

Step 3

The third step requires you to select a 

database of questions to use. 

Clicking on the  <Click to select> 

text opens up the Select Database 

dialog which lets you pick a 

database.

You may encounter the following 

message.

This means that INFINITY Test and Homework Generator has found no databases in the 

default directory. This can happen if your school has chosen to store its question 

databases elsewhere. Simply click on Yes and navigate to where the question databases 

are installed. 
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Step 4

Databases in the INFINITY Test and 

Homework Generator directory are shown 

in the list (again, this may be changed 

through the Preferences dialog). 

If the database you want is not shown, 

clicking the Browse button allows you to 

locate a database stored elsewhere on your 

computer or network.

Clicking on OK returns you to the previous 

screen.

Step 5

If you did not choose a template you 

can supply information which the 

Test Wizard will use to put headers 

at the top of the test and solution 

pages.

The other options that can be 

specified at this point are:

Include marks: whether allocated marks should be shown after each question

Autospace questions: whether space should automatically be inserted between 

questions (based on the amount of space required by the worked solution)

Show codes: whether question syllabus codes should be printed (New Zealand 

textbook databases only).
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Finished

That is all the information needed by 

the Test Wizard to create your test. 

Clicking on Finish will close the 

dialog and open the database.

You can now begin selecting 

questions for inclusion in your test 

(see Browsing and Selecting 

Questions on page 23).

The headers can be further customised or edited by selecting Test Header from the View 

menu or clicking the Edit Test Header button on the toolbar. See Creating Test and 

Solution Headers on page 24 for more information. 

Step 6 (Exam Style only)

If you have chosen Exam Style, the 

Test Wizard allows you to enter any 

instructions to students that you want 

shown on the cover page. 
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Registration of databases (if needed) (See page 17)

Converting Old Databases
If you already have an older Test Generator installed, you can use the databases from 

that version. However, INFINITY Test and Homework Generator needs to convert this 

database into a new form. While this is done automatically for any databases installed 

when you upgrade to INFINITY Test and 

Homework Generator, sometimes you 

need to open an older database after 

INFINITY has been installed.

When converting a database you are prompted for a new location and name. Clicking 

Save starts the conversion program. When the database has been converted, INFINITY 

Test and Homework Generator continues.

Important: If the database you are converting is designed for use with the 'old' Test 

Generator (where individual questions could not be customised), you will not be able to 

customise individual questions in the database using the INFINITY Test and Homework 

Generator software.

Administrators may convert old databases using the supplied tool ConvertTestDB.exe 

located in the same directory as INFINITY. The tool may be run in quiet mode (/q) hiding 

the progress bar.

Usage:  ConvertTestDB [/q] path-to-old-database.mdb path-to-new-database.tdb

Selecting a Question Database

Before questions can be inserted into a test, a 

database of questions must be selected. 

Each available question database contains 

questions suitable for the topics covered in its 

associated text book.

A question database can be selected in one 

of two ways:

• Using the Test Wizard.

• Choosing Select Database from the 

File menu (or using the shortcut Ctrl+D).

Databases stored in the same directory as INFINITY Test and Homework Generator are 

listed automatically. A question database stored in a different directory can be accessed 

by clicking on the Browse... button, then navigating to the database's location.

Note: It is not possible to construct a test using questions from more than one database. Selecting a new 

database closes the currently open test and creates a new test, with the new database's questions to 

choose from. 
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The Selected Chapter box at the top of the window allows you to limit the questions 

displayed to a particular chapter.

To add or remove questions to a test simply click on the check box marked Include In 

Test. The Insert and Delete keys also add and remove questions from the current test. By 

default questions are numbered in the order that they are inserted. It is also possible to 

insert questions at the beginning or at a specified position within the test by selecting 

Insert Question At Beginning and Insert Question At... from the Question menu.

The Number control on the Question Details panel shows you what number the 

question is in the test (the control is greyed out if there are less than two questions in the 

current test). If the question is in the current test, you can use the  control to move the  
question up or down in the test. You may move a question to a specified position number 

by selecting Shift Question To... from the Question menu. Questions can also be 

dragged around while previewing a test if the edit (  )  tool is selected from the toolbar 

(see Previewing and Printing a Test, page 26).

The Marks control on this panel shows you the default number of marks allocated to a 

question. You may edit it here, or while previewing a test using the edit tool to click on the 

marks for a question (see Previewing and Printing a Test, page 26). The marking total 

for a test is automatically recalculated if you change the number of marks assigned to a 

question.

Note: Questions can be selected from more than one chapter. To do this change the selected chapter after 

including the desired questions from the current  chapter. 

Browsing and Selecting Questions

Once a question database has been 

loaded, questions can be browsed in 

a number of ways:

• using the horizontal slider on 

the Question Navigation 

panel

• using the forward and back 

buttons on the Question 

Navigation panel

• using the Page Up and Page 

Down keys.

The question and answer appear in the same window, but get separated into the question 

and answer sheets when the test is printed.
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Custom headers for both test papers 

and solution pages can be easily 

constructed in the header edit 

window. This can be opened by 

selecting Test Header from the View 

menu, clicking the View Test Header 

button, or using the keyboard shortcut 

Ctrl + H.

The test header editor acts like a 

simplified word processor, allowing 

you to select font size and attributes, 

paragraph alignment, etc. The 

formatting options are not as 

complete as a stand-alone word 

processor, so you may lose some 

formatting if pasting text copied from another application. You can try getting around this 

by using the Paste as picture button in the toolbar.

Shortcuts for the Test Header Editor

Ctrl + X Cut selected text to clipboard

Ctrl + C Copy selected text to clipboard

Ctrl + V Paste clipboard contents into header

Paste clipboard contents into header as picture

Apply bold typeface to selected text

Apply italic typeface to selected text

Apply underline typeface to selected text

Ctrl + L Left align paragraph

Ctrl + E Centre align paragraph

Ctrl + R Right align paragraph

Apply bullets to paragraph

Ctrl + Z Undo last edit

You can switch between the test header, the solution header and the first page header 

(Test style) or the cover sheet (Exam style) by clicking on the tabs. You can use the style 

drop-down box at the bottom of the window to switch between the three styles of headers:

• All headers the same

• Separate cover sheet

• Different header on first page.

Creating Test and Solution Headers



25INFINITY Test and Homework Generator

Using Test Templates

INFINITY Test and Homework Generator provides the facility to create a template, on 

which new tests can be based.

Templates provide uniform headers for the question paper and solution sheet, as well as 

any cover pages (for exam-type tests), saving the user a lot of time.

Create a test with the headers and cover sheet (if applicable) that you want.

Then, select Save As Template... from the File menu. Name the template and save the 

file in a suitable location.

This template may now be used to create new tests by anyone with access to INFINITY 

and the template.

Select New From Template... from the File menu (bypass the Test Wizard if it comes 

up).

You will be prompted to select a database for 

your test. Select the desired database, and 

click OK.

You will now be prompted for the template's 

location. Navigate to where the template is, 

select it, and click Open.

Now, select the questions you want in the test, just as you normally would. The headers 

will be the same as they are in the template you selected.

Creating new templates

Using an existing template

Step 1

Step 2

Step 1

Step 2

Step 3

Step 4
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Previewing and Printing a Test

Test papers and solutions can 

be previewed by clicking on 

the Print Preview button  at 

the top of the question 

selection window.

The magnification of the 

preview window can be 

changed by selecting a zoom 

ratio from the drop down box 

in the preview toolbar. Clicking 

on the preview page using the 

zoom tool alternates the zoom 

from Page Height to Page 

Width.

To view a different page press 

Page Up or Page Down on the keyboard or scroll past the end of the current page using 

the mouse wheel.

The edit tool is used to change the spacing and order of questions in the test. When the 

edit tool is selected, clicking on a question surrounds it with a red rectangle. The 

rectangle shows the borders of the question, including space left for student working. 

When selected, a question can then be dragged to another location in the test. To move a 

question to the previous or next page, press Page Up or Page Down while dragging the 

question.

Extra space can be added or removed between questions by clicking and holding the 

mouse button while positioned at the bottom of the selected question (the cursor will 

change to   ). 

The number of marks allocated to a question can also be changed. Click on the 

allocated marks for a question (it will be on the right, and have the form [... marks]) and 

then type the new mark allocation in the highlighted text box.

When a question is selected and the Delete key is presssed the question will be removed 

from the test. 

If a question is right-clicked a menu will be displayed, providing quick access to various 

functions. These can otherwise be accessed from the menus of the main window.

Edit tool (  )
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Open the print dialog

Page setup

Select the zoom tool

Select the edit tool

View margins

Edit test headers

Use suggested marks

Show marks on test

Autospace questions

Shortcuts

Margins and Printing

Page margins are shown as dashed lines. These margins can be shown (or hidden) by 

clicking on the View margins button on the toolbar. Page margins can be changed by 

clicking on the page setup button on the preview toolbar, or selecting Page Setup... from 

the File menu. It is also possible to specify different margins for the cover page.

Clicking on the Print button on the preview toolbar opens the print dialog box, where you 

can print the test paper and/or answer sheet.

Zoom In

Zoom out

Select the zoom tool

Select the edit tool

Close the preview window

Previous Page

Next Page

Hot Keys

Directional scrolling

+

-PgUp

PgDn

E

Z

Esc
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7. Customising Questions

INFINITY Test and Homework Generator allows you to customise almost all of the 

questions in one way or another.

Each question will have its own interface for customising it. However, these are the 

general controls you can expect to see:

Used when there are a number of choices, 

from which you may choose only one.

Used when there are a number of choices, 

and you may specify any or all of them.

Used to specify a value for a single variable 

(such as a name, or an equation type).

These allow you to type in your own value for 

the variable. They may accept text or 

numbers (or a combination), depending on 

the variable. Each text entry box has a yellow 

tooltip that tells you what you may enter.

Radio Button

Check Box

Drop-down 

Menu

Text Entry 

Box

Building Expressions

Basic operators

A number of questions require a particular style of input, particularly those involving 

BEDMAS or algebraic expressions.

Individual questions may have additional limits on what the user may enter; these will be 

given in the tooltip for that particular text entry box. However, even if no such limits are 

given, users are encouraged to use their common sense when entering an expression, or 

alternatively allow the question to generate the expression for you.

General guidelines for expression input are listed below.

For addition and subtraction, use the + and – symbols. For example, typing in "3+8" 

results in the question text displaying 3¡+¡8. The – symbol can also be used to enter 

negative numbers.

For multiplication, use the * symbol. For example, typing in "3-8*4" results in the question 

text displaying 3¡-¡8¡*¡4.  You can enter expressions that contain implicit multiplications. 

For example, if you type in “3(2a+1)”, it is interpreted as  3¡* (2 * a + 1).
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For division, use the / symbol. (Make sure you use the forward slash /, not the backward 

slash \ !) For example, typing in "12/3-5" results in the question text displaying QdW   -¡5 or 

12¡/¡3¡-¡5, depending on the question format. To enter mixed fractions, use a space 

between the integer and fraction parts. For example, typing in "6 1/4" results in the 

question text displaying  6 Qr .

You can use brackets to build expressions. For example, typing in "5*(2+7)" results in 

5¡*¡(2¡+¡7).

In particular, brackets are useful for building expressions involving a fraction bar. For 

example, typing in "(8*7-2)/(14-5)" results in .   
Brackets may be nested. For example, typing in "((4+2)*5)/6" results in    or   
((4 + 2) * 5) / 6 .

The ̂  symbol is used to separate the base and exponent. For example, typing in "2^7" 

results in 27 .

You may use the ^ symbol as part of a larger expression. For example, typing in 

"4*(3^2-1)" results in 4 * (32 - 1).

To build an expression that contains a function, you enter the name of the function and 

follow it with a pair of parentheses containing the letter, number, or expression that this 

function is being applied to. For example, typing in “sin(3+x)” results in  sin(3 + x).

For square roots, the function "sqrt(expr)" is used. For example, typing in "sqrt(s+4)" 

results in ~`s` #+` 4 .

For higher roots, the command "root(expr,rootno)" is used, where expr is the expression 

that you want to appear under the radical sign, and rootno is the root you want. For 
 10example, typing in "root(x-1,10)" results in ~`x# -` 1 .

Typing in “pi” will result in  p,  which represents the mathematical constant  p  in the 

evaluation of the expression.

Brackets

Exponents

Functions

thSquare roots, cube roots and n  roots

Pi

Note: The functions available include:  cos, sin, tan, sqrt, root, log, ln,  and  abs.

Note: You can also enter in square roots using this command, ie “root(x,2)”.

8£ 7¡ 2

14¡ 5
(4 + 2)£ 5

6
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Writing New Questions

It is possible to write a question in any program 

that is capable of copying to the clipboard; 
®Microsoft  Word is such a program.

This question, along with a corresponding 

solution, can then be added to an existing 

question database and used in the construction 

of tests. This is done by selecting Manage 

Custom Questions... from the Question 

menu, then clicking the Add... button.

You can also use Manage Custom 

Questions... to access and/or modify custom 

questions that have already been created.

Custom questions need to be added to all 

databases that you wish to use them in. For 

example, if you have added a question to your 

Year 8 question database, you will not be able 

to use it in tests based on your Year 9 database without first adding the question to the 

Year 9 database.

Custom questions should be a maximum of 13 cm wide. If you want custom questions to 

blend in with existing ones, use 10 point Times New Roman for the font.

Solutions should be a maximum of 6.5 cm wide; again, use 10 point Times New Roman for 

the font. Microsoft® Word makes the solution as wide as the page (excluding margins) 

regardless of the actual width of text on the page, so you may find that altering the page width 

to 6.5 cm when writing answers will give the best results. 

Note: Custom questions that you add to a database will not be available to other users. If they wish to use your 

question, they need to add it themselves using this same method.

Questions

Solutions
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8. Troubleshooting

I get the error message “Can’t load required fonts from the file ‘fonts.dat’”. 

Some questions appear to have odd symbols instead of +, –, etc.

I get the error message “Can’t load required images from the file 

‘graphics.dat’”. Some (or all) of the icons are black in the menus and toolbars.

After installing my database I can’t find it in INFINITY Test and Homework 

Generator.

During Installation a “Database Installation Error” occurred. The error message 

had a list of databases and read “The question databases listed below could 

not be installed”.

Geometry figures do not print at the correct sizes.

My question isn’t answered here. Help!

This means the fonts data file can’t be read, or has been corrupted.

• Reinstall INFINITY Test and Homework Generator by using the Windows 

Add/Remove Programs tool to remove it and then installing again from the CD.

This means the images and icons data file can’t be read, or has been corrupted.

• Reinstall INFINITY Test and Homework Generator by using the Windows 

Add/Remove Programs tool to remove it and then installing again from the CD.

Make sure you installed the database in the right location. The default location 

where INFINITY Test and Homework Generator searches for databases is the 

directory named ’db’ inside the directory where INFINITY was installed. By default 

this is C:\Program Files\Haese & Harris Publications\Test Generator\db\

Try reinstalling the question database from the CD and provide the correct location.

The most likely causes are that either the chosen installation location had 

insufficient space, or the installation process was interrupted.

• Ensure sufficient space is available and re-run the installer (this will not reinstall 

the software).

• Try installing the software and databases to a different location.

• Manually copy the database from the CD into the location in which INFINITY was 

installed (database files are *.tdb).

This is because the printer settings being used are not correct. Turn off any page 

scaling and ensure the paper size being used is A4. In INFINITY, the page size can 

be adjusted by selecting File>Page Setup.

You will need to contact Haese Mathematics Technical Support. See Contacting 

Technical Support, on page 32. 
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Reporting a Bug

Haese Mathematics are happy to rectify any bugs found in our software, even minor 

ones. These may include:

• Typographical errors, such as incorrect spelling or grammar

• Incorrect steps in the worked solution for a question

• Errors in how a question calculates the answer

• Question or solution text not generating.

To report a bug, select Report A 

Problem... from the Help menu.

Select the type of problem from the 

Problem related to drop-down 

menu, and in the space below provide 

a brief description of the issue.

If you want to be kept updated on the 

progress of this problem (including 

when it has been resolved), then type 

your email address in the space 

provided.

When you are finished, click Send to 

send the issue through to Haese 

Mathematics.

Please have ready details of the problem you are experiencing, including (if applicable) 

the database in question, the question ID (e.g. [17-06]) and a brief description of the 

issue at hand.

Technical support can be provided either via email, or over the phone. Here's how to 

contact us:

Telephone (within Australia): (08) 8355 9444
Telephone (rest of the world): +61 8 8355 9444
Email: testgen@haesemathematics.com.au

The Bug Reporting System

Contacting Technical Support

Note: You can not use the Report A Problem 

feature to request technical support. In 

this case, you need to contact Technical 

Support directly (see below). 
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9. Appendices

Menus and Toolbars Reference

Main toolbar

View Header toolbar (Test Headers dialog box)

 Ctrl + N  Make new test using current database

Ctrl + O Open existing test

Ctrl + S Save current test

Ctrl + D Select a question database

Ctrl + P Show the print dialog

Ctrl + T Open print preview, showing test paper

Ctrl + A Open print preview, showing answer sheet

Ctrl + H Edit test headers

Ctrl + L Limit question navigation to questions in test

PgUp Go to previous question in database

PgDn Go to next question in database

Ctrl + PgUp Go to previous question in test

Ctrl + PgDn Go to next question in test

Ctrl + R Remove question from test

Ctrl + I Insert question at end of test

Ctrl + Up Shift question up

Ctrl + Down Shift question down

Shift question to...

F1 Show help file

Ctrl + X Cut selected text to clipboard

Ctrl + C Copy selected text to clipboard

Ctrl + V Paste clipboard contents into header

Paste clipboard contents into header as picture

Apply bold typeface to selected text

Apply italic typeface to selected text

Apply underline typeface to selected text

Ctrl + L Left align paragraph

Ctrl + E Centre align paragraph

Ctrl + R Right align paragraph
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Apply bullets to paragraph

Ctrl + Z Undo last edit

Open the print dialog

Page setup

Select the zoom tool

Select the edit tool

View margins

Edit test headers

Use suggested marks

Show marks on test

Autospace questions

Ctrl + N New test using current database

Ctrl + Shift + N New test using test template

Ctrl + O Open existing test

Ctrl + W Run the Test Wizard

Ctrl + D Change database and create a new blank test

Ctrl + S Save current test

Ctrl + Shift + S Save current test using a new name

Ctrl + Alt + S Save current test as a template

Page setup

Ctrl + Alt + P Opens print preview window

Ctrl + P Show the print dialog

Alt + F4 Exit INFINITY Test and Homework Generator

Ctrl + H View/edit test headers

Ctrl + T Opens print preview, showing test paper

Ctrl + A Opens print preview, showing answer sheet

Ctrl + R Remove question

Ctrl + I Insert question at end

Ctrl + Shift + I Insert question at beginning

Ctrl + Alt + I Insert question at...

Print preview toolbar (Print Preview window)

File menu

View menu

Question menu
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Ctrl + Up Shift question up

Ctrl + Down Shift question down

Shift question to...

Ctrl + G Generate question

Manage custom questions...

Include marks (toggle)

Autospace questions (toggle)

Show question codes (toggle)

'Question codes' are the syllabus reference codes 

for each question (NZ question databases only)

Ctrl + Alt + G Generate all questions...

Quickly generates a test using the same questions 

and parameters, but different numbers.

PgDn Go to next question in database

PgUp Go to previous question in database

Ctrl + PgDn Go to next question in test

Ctrl + PgUp Go to previous question in test

Ctrl + L Limit question navigation to questions in test (toggle)

Preferences...

Check for Updates...

Licence Manager...

F1 Show help file

Shift + F1 View this Manual

Customer Feedback...

Report A Problem...

About

Test menu

Navigation menu

Tools menu

Help menu
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10. Index

adding and removing questions 23,30

basic operators 28

BEDMAS expressions 28

brackets 29

bugs, reporting 32

check box 28

checking for updates 17

contacting Technical Support 32

converting databases 22

ConvertTestDB.exe 22

cube roots 29

custom headers 24

customer information screen 4, 12

custom questions 30

customising questions 28

drop-down menu 28

edit (hand) tool 26

exam style 19, 21

exponents 29

expressions, building 28

finding old Test Generator databases 15

fractions 29

functions 29

header styles 24

higher roots 29

including questions in tests 23

installation directory, changing the 13

installing INFINITY Test 

and Homework Generator 4, 11-15

licence Manager 16

manage custom questions 28

marks allocation 20, 23, 26

minimum system requirements 10

mixed fractions 29

navigation buttons 8, 33

new questions 30

page setup 27

pi (p) 29

print margins 27

print preview 8, 26

printing tests 8-9, 26

question navigation 23

question order, changing 23, 26

question spacing 20, 26

radio button 28

recommended system requirements 10

report a problem tool 32

selecting a chapter 23

selecting a database 22

selecting questions 8, 23

square roots 29

test creation wizard 6, 18

test header editor 24

test style 19

test templates 25

creating new templates 25

using existing templates 25

text entry box 28

tooltip 28

updating databases 17

(see also converting databases)

updating licences 16

updating INFINITY Test 

and Homework Generator 17

upgrading from Test Generator 16

writing your own questions 28

zooming in/out 26
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Haese Mathematics
152 Richmond Road, Marleston,  SA 5033, AUSTRALIA
Telephone:  +61 8  8210 4666,   Fax:  + 61 8  8354 1238
Email:  
Web:

info@haesemathematics.com.au
www.haesemathematics.com.au
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